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Tips for Formatting APA Papers Using Microsoft Word 
Formatting APA papers using Microsoft Word can be challenging if you are not used to using the software. Luckily, Microsoft has several built-in shortcuts and tools that can help to simplify formatting your paper to APA standards. Use the following tips to assist you in formatting your APA paper.

Margins
APA (7th edition) requires that papers have a one-inch margin on all sides of each page. To set your margins so that they adhere to APA guidelines, use the following steps:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you do not have anything written yet, doing so will ensure that the margin settings apply to the entire paper, not just the first page).
2. Click on the “Page Layout” tab of the Word menu.
3. Click on the “Margins” dropdown menu button.
4. Select the “Normal” option showing one-inch margins on each side of the page.
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Page Numbers
APA requires that papers have page numbers in the upper right-hand corner of every page. To insert page numbers that will automatically carry over onto every new page of your document, use the following steps:

1. Click on the “Insert” tab of the Word menu.
2. Click on the “Page Number” dropdown menu button. 
3. Click on the “Top of Page” submenu.
4. Select the “Plain Number 3” option that shows the page number appearing on the right-hand side of the header.
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5. Press the “Ctrl” and “A” keys on your keyboard at the same time to select all text in the header and change the font to Times New Roman 12pt so that it matches the font of the rest of your paper (ALL text in your paper should be in Times New Roman 12pt).

Title Page
APA requires that papers begin with a title page. Your APA title page should include, in this order, your paper’s title (written in bold text), your first and last name, your institution of affiliation (a.k.a. the school you’re attending, Pensacola State College, and the department of the course for which you are writing the paper), the course number and name, your instructor’s name, and the assignment due date. Your title page information should be centered in the upper half of the page, double spaced, and typed in 12-point Times New Roman (ALL text in your paper should be double spaced and in Times New Roman 12pt). 

Capitalize the first and last words of the title and all other words except for articles (a, an, and the), prepositions (in, of, to, for, etc.), and coordinating conjunctions or FANBOYS (for, and, nor, but, or, yet, and so) unless those exception words appear as the first or last word of the title or the first word in a subtitle following a colon. Your title should not be underlined or italicized. Your name, the name of your affiliated institution, and all other necessary information should be double-spaced and centered and should appear directly beneath your title.

Your title page should look similar to the sample below:
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Some professors may require that you include other information on your title page. If your professor asks for any more information, defer to your professor’s instructions and include all information they may require.

Spacing

According to APA, your entire paper should be double spaced. Use the following steps to double space your paper:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you don’t have anything written yet, doing so will ensure that the double spacing applies to the entire paper, not just the first line).
2. Click on the expand button ([image: ]) in lower right-hand corner of the “Paragraph” section of Word’s “Home” menu to open paragraph window (see image below for more detail).
[image: ]
3. Once in paragraph window, select “Double” from the “Line Spacing” drop-down menu.
4. Make sure that both the “Before” and “After” fields say “0 pt” to remove/prevent any extra spacing.
5. Check the box next to “Don’t add space between paragraphs of the same style.”
6. Before closing the paragraph window, make sure that it resembles the example below.
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Abstract
APA suggests including an abstract between your title page and the first page of your paper; however, some professors do not require the abstract. Be sure to check with your professor if you are not sure whether to include an abstract in your paper. If you do choose to include an abstract, it should appear alone on its own page. Your abstract should briefly summarize the main points and purpose of the paper and should not be more than 120 words. It should be double-spaced and typed in 12-point Times New Roman. DO NOT indent the abstract paragraph. As a title, the word “Abstract” should appear centered at the top of the page in 12-point Times New Roman.

The page following the abstract will begin the text of your paper. It should begin with your paper’s title centered at the top of the page followed by the paper’s first paragraph left justified and indented.
 
Paragraph Indents
According to APA, all paragraphs should be indented one half (.5) of an inch. To set Word to automatically indent your paragraphs each time you hit the “enter” key on your keyboard, use the following steps:

1. If you are unable to see a ruler between the bottom of the Word menu and the top of your page, perform these steps before moving on to step two:
a. Click on the “View” tab of the Word menu.
b. Check the box beside the “Ruler” option of the “Show” section of the menu.
c. Now the ruler should be visible as shown below.

[image: ]

2. Now that you can see the ruler, you can add your indent. Hit the “Enter” key to move onto the line directly below your title (there should be no extra lines between your title and the first line of your paper’s first paragraph) and click on the left justify button 
([image: ]) to return your cursor to the left-side margin of your page.
3. Click and drag the top triangle on the ruler’s left-hand margin so that it sits on the line halfway between your left-hand margin and the “1” on the ruler. Your ruler should end up looking like the example below.

[image: ]

Now Word will automatically indent half an inch every time you hit the “Enter” key to move on to a new paragraph.  If you need to remove this automatic indent for any reason, all you have to do is place your cursor before the indent and press the “Backspace” key to delete it.

Block Quotations
APA states that when a quotation is 40 words or more, it should be formatted as a block quote. Block quotes are set apart from the text of your paragraph and indented one half (.5) of an inch from the left margin. To correctly format a block quote, use the following steps:

1. First, introduce your lengthy quote with a complete sentence and a colon (:).
2. Type out your quoted material without any quotation marks (the block format will take the place of quotation marks to show that the material is from another source). 
3. Be sure to include a citation following the quote. Unlike with shorter quotations, the period ending the quotation sentence will fall directly following the quote with the citation falling outside the sentence altogether.
4. Now, type another sentence addressing your quote (this step is important both for your paper’s effectiveness and for the formatting of your block quotation).
5. Place your cursor before the quote and press the “Enter” key as if you are starting a new paragraph.  If you have automatic indents set, press the “Backspace” key once to remove the indent.
6. Place your cursor before the sentence following your quote and press the “Enter” key as if you are starting a new paragraph.  If you have automatic indents set, press the “Backspace” key once to remove the indent so that the remaining text of your paragraph after the quote will start at the margin, eliminating any confusion for your reader.
7. Select the entire quote and citation.
8. Press the “tab” key once to indent the entire quotation one half inch from the margin.
9. Your block quote should end up looking like the example below.
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Try not to use too many block quotes in your paper. Your own words should make up the bulk of your paper’s text.

Hanging Indent
Each citation on your References page should be formatted with a hanging indent.  A hanging indent occurs when the first line of the citation begins on the left-hand margin and the second line of the citation is indented half an inch from that margin.  To format your References page using hanging indent, use the following steps:

1. Place your cursor at the very end of your paper and press the “Ctrl” and “Enter” keys at the same time to create a page break.
2. If Word automatically indents on the new page, press the “Backspace” key once to delete the indent.
3. Click on the center button ([image: ]) in the “Paragraph” section of Word’s “Home” menu.
4. Type “References” (without quotation marks) in bold as your title.
5. Press the “Enter” key and click on the left justify button ([image: ]) to return your cursor to the left-side margin of your page.
6. Type out all of your References page citations, pressing the “Enter” key after each citation.
7. Select all of your citations, but do not select page’s title.
8. Press the “Ctrl” and “T” keys at the same time to format your hanging indent automatically.
9. Your citation(s) should end up looking like the example below.

[image: ]

The citations on your References page and your in-text citations should follow APA guidelines. For more information regarding APA citations, see the Pensacola State College Writing Lab’s APA handout or reference the Purdue OWL APA Formatting and Style Guide.  
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Some perotessors require that you mclude other mtormation (e.g. the paper’s word count) 1 your

heading. This information should be included on the line directly following the header

(underneath the date). If your professor asks for something other than the standard MLA header,
N defer to your professor’s instructions.

Spacing

According to MLA, your entire paper should be double spaced. Use the following steps to
double space your paper:

1. Press the “Ctr]” and “A” keys on your keyboard at the same time to select the entire
paper (even if you don’t have anything written yet, doing so will ensure that the double
spacing applies to the entire paper, not just the first line).

2. Click on the expand button () in lower right-hand corner of the “Paragraph” section of
Word’s “Home” menu.

3. Select the “2.0” option.
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1. If you are unable to see a ruler between the bottom of the Word menu and the top of your
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B c. Now the ruler should be visible as she below.

paste B I U-moxx A-%-A- Hedng? T st SubteEn. 6
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Blackbeard and his crew were some of the most successful pirates on the open seas. This
success stemmed from their ability to use effective pirating tactics to prey on unsuspecting ships.
Blackbeard and his crew used one specific tactic to great success:

They ambushed ships carrying passengers and cargo in the dim light of dawn and dusk

when the pirates' ship was hard to see. The pirates often determined a ship's nationality

first. Then they raised that country's flag on the pirate ship so they appearedto be
friendly. Now able to draw close to the unsuspecting ship, the pirates hoisted

Blackbeard's flag only at the last moment. (Kirkpatrick)

By giving victim ships a false sense of security, Blackbeard and company were able to use the

element of surprise to their advantage. After successfully ambushingthe target ship, they would

begin the process of boarding and plundering, gathering their booty from the spoils of the

ambushed ship.
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Your title should also be centered according to MLA format guidelines. To center your title, use

the following steps:
1.

Select your entire title.

2. Click on the center button () in the “Paragraph” section of Word’s “Home” menu.
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